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JURUSAN TEKNIK KOMPUTER
PROGRAM D3 TEKNIK KOMPUTER
POLITEKNIK NEGERI SRIWIJAYA PALEMBANG

SI

PEMROGRAMAN BERORIENTASI Praktikum 1 Pengantar OOP Waktu 90
OBJEK menit

Lecturer : M. Miftakul Amin, S. Kom., M. Eng.

Tujuan : 1. Mahasiswa mengetahui konsep berorientasi objek.

2. Mahasiswa dapat menjelaskan fitur-fitur java.
3. Mahasiswa dapat mengoperasikan software netbeans 6.0.

Perlengkapan : Software Netbeans. 6.0

Sejarah Java

Pada tahun 1999 Sun Microsystem membagi paket java menjadi 3 bagian utama, yaitu :
- Java 2 Standard Edition (J2SE).

- Java 2 Micro Edition (J2ME).

- Java 2 Enterprise Edition (J2EE).

Tujuan pembagian paket aplikasi ini adalah agar java dapat mengakomodasi seluruh
model aplikasi yang dibutuhkan user. Java mempunyai semboyan Write Once Run Anywhere
(WORA), yang berarti bahwa dengan sekali menulis program java, maka aplikasi tersebut dapat
dijalankan di platform mana saja.

Pada tahun 1991, Sun dipimpin Patric Naughton dan James Gosling ingin merancang
bahasa computer untuk perangkat consumer seperti cable TV Box. Karena perangkat itu tidak
mempunyai banyak memori, bahasa harus berukuran kecil dan menghasilkan kode program
yang liat. Juga karena manufaktur-manufaktur berbeda memilih pemroses-pemroses yang
berbeda, maka bahasa harus bebas dari arsitektur manapun. Proyek ini diberi nama kode
“Green”.

IDE Netbeans 6.0

Netbeans merupakan paket aplikasi terintegrasi yang dapat digunakan untuk mengembangkan
aplikasi tidak hanya java tetapi juga mendukung bahasa pemrograman yang lain seperti:

- C

- C++

- Ruby

- PHP

- Groovy.

Untuk mendapatkan versi terbaru dari netbeans, dapat mendownload dari alamat situs
http://www.netbeans.org.

Beberapa platform sistem operasi yang didukung oleh netbeans antara lain:
- Windows XP/Vista/2000

- Linux x86

- Linux x64

- Mac OS x

- Solaris x86

- Solaris x64

Platform JDK java yang digunakan oleh netbeans adalah versi 5 ke atas.
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Berikut merupakan tampilan lingkungan kerja Netbeans 6.0

W NetBeans IDE 6.0 E”@lg
File Edit View Mavigste Source Refactor Buld Run  Profile  Versioning Tools Window Help

PEHEY XEEDCE s O TH D B O

: Projects |Files | Services 40 x| ..va [0 Frmpetugas.java x| StartPage x| [0 SIPMBWiewjava x| A =@

#- & Databases
-8 wieb Services
@ Enterprise Beans (2.x)

& NetBeans

[EH servers
My NetBeans
~
Cannot connect ta internet,
:Navigator a x <nio recent projects Preocy Canfiguration, .,
ALL NEWS >> ALL ARTICLES >>
Cannot conneck to internat, Cannot connect to internet, 2
ALL DEMOS >> ALL BLOGS >>
: Dutput = x| Junit Test Results |:usages |:HTTP Manitor
[l | stpv run) < | S1PMB (run) #2x |
| amie: &
deps-jar:
compile:
run:
EUILD ESUCCESSFUL (total time: 8 minutes Z& seconds)
v

: Projects I Files - Services

E Databases
@ Web Services
@ Enterprise Beans (2.x)
=-FF servers
--%F\pache Tomcat 6.0.14
- €5, pGlassFish Y2

Netbeans juga mendukung integrasi dengan database server, seperti MySQL.

‘Projects | Files | Services il =
=& Databases ~
E}ﬁ Drivers
@ IDEC-ODEC Bridge
B MySOL (Connectar/] driver) 3
B Java DB (Mebwoark)
P Java DB (Embedded)
------ PostgrescL
E}Eﬂ jdbc:derbey: ) flocalhost: 1527 fsample [app on APF] b
< |
3. Fitur-Fitur Java
a. Applet.
b. Java Networking
c. Java Database Connectivity
d. Java Swing
e. Java RMI
f. Java Security
g. Java Server Pages (JSP)
h. Java Corba
i. Dl

Netbeans mendukung integrasi dengirf aplikasi server pihak ketiga.
41 =
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4. Konsep Pemrograman Berorientasi Objek
- Abstaksi
- Enkapsulasi
- Inheritamce
- Polymorphism

Tugas Praktikum :
1) Jelaskan bagian-bagian penting dari lingkungan kerja netbeans 6.

Diperiksa tanggal : Nama Laboratorium : Nomor Komputer :
Dosen Pengampu:
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JURUSAN TEKNIK KOMPUTER
PROGRAM D3 TEKNIK KOMPUTER
POLITEKNIK NEGERI SRIWIJAYA PALEMBANG

SI

PEMROGRAMAN BERORIENTASI Praktikum 2 Tipe Data, Variabel
OBJEK dan Operator

menit

Lecturer : M. Miftakul Amin, S. Kom., M. Eng.

Tujuan : 1. Mahasiswa mengenal bermacam-macam tipe data, variable, dan operasi
dalam java.
2. Mahasiswa dapat menentukan dan menggunakan tipe data, variable dan
operasi dalam pemrograman java.
Perlengkapan : Software Netbeans. 6.0
1. Membuat Project

Project merupakan sebuah container atau pusat penyimpanan file-file yang digunakan dalam
mengembangkan aplikasi. File project biasanya berisi file dengan ekstensi .java, .class, .png,
Jar, dil.

Untuk membuat project baru anda dapat mengikuti langkah-langkah berikut:

Buat project baru dengan nama OOP,dari IDE netbeans 6.0 yang aktif pilih File>New Project.
Sesaat kemudian akan ditampilkan window pembuatan project.

W OOP - NetBeans IDE 6.0

Edit Wiew Mawigate Source Refackor
"i MNew Project. ..

E] PMew File. .,

Pada window New Project yang aktif, pada bagian Categories: pilih Java, pada bagian
Projects: pilih Java Dekstop Application. Klik tombol Next>..

Chrl+3hifk-+1
ChrlHr

Steps Choose Project

1. Choose Project Categories:

2, [ [ @ Java

Projects:

Waktu 90

M-I Samples

&5 Java Class Library
Q Java Project with Existing Sources
-ﬁ Java Project with Existing Ant Script

Descripkion:

database table.

Creates a skeleton of a deskkop application based on the Swing Application Framework (ISR 296),
This template provides basic application infrastructure such as a menu bar, persisting of window
state, and status bar, With this template, you can also generate code ko create a GUI interface for a

Tahap selanjutnya akan dimunculkan window untuk menentukan nama dan lokasi penyimpanan
file project. Pada bagian Project Name isi dengan OOP, pada Project Location pilih alamat
misal D:\Praktikum (sesuaikan dengan instruksi pada saat praktikum), kemudian centang
pilihan Set as Main Project. Kemudian pada bagian Choose Application Shell pilih Basic
Application. selanjutnya klik tombol Finish.
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@ New Desktop Application

Steps Name and Location

1. Choose Project Praject Mame: |oop| \
2. Name and Location

Project Location: iD:'l,Praktikum \[ Browse. .,

Project Folder; !D:'l,Praktikum'l,OOP ‘

Set as Main Praject

Application Class: !oop.OOPApp

Choose Application Shell

[& Basic Application & basic application skeleton containing everything needed  #
@ Database Application ko start with a general desktop application, such as the
Following:

# main frame with a menu bar and status bar

# About box

# main Application class

# implementation of status bar messages and
progress indication

# resource management mechanisms o better Er
handle loading of icons and strings v

Mexk = [ Finish H Cancel H Help ]

Selanjutnya anda dapat memeriksa pada bagian Project terdapat sebuah project baru dengan
nama OOP. Untuk selanjutnya anda dapat menggunakan project OOP ini untuk praktikum
selama 1 semester ke depan.

W 0OP - NetBeans IDE 6.0

File Edit ‘iew Mavigate Source Refackor Build Run  Profile  Wersioning

I]JF__I El % % |j| = ¢ |{defaultcnnﬁg>

: Projecks 1 = | ‘Files - Services

v
EQ oopP i
E}uﬁ Source Packages

&[] META-INF

- META-IMF services

=[] oo

- ooPaboutBox.java

|?_5| OOPApP.java

-8 oorviewjava

Anda dapat memperhatikan bahwa pada bagian project anda terdapat 3 buah file yang
ditambahkan secara otomatis pada project.
1) OOPAboutBox.java
Bagian ini berisi informasi tentang project yang telah dibuat. File ini berisi about dari aplikasi.
2) OOPApp.java
File ini akan dieksekusi pertama kali, ketika project anda dijalankan.
3) OOPView.java
File ini merupakan menu utama tempat seluruh aplikasi anda akan diintegrasikan.
2. Menjalankan project
Untuk menjalankan project anda dapat menekan tombol anak panah warna hijau pada bagian
toolbar. Atau dengan menekan tombol F6 pada keyboard.

MY E DB

Sesaat kemudian akan dimunculkan sebuah window yang berisi aplikasi yang anda buat.
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B Basic Application Example
File Mg
Abaut. ..

3. Menambahkan Form
Untuk menambahkan form ke dalam project, anda dapat mengklik kanan nama project->pilih
New->JInternalFrame Form.
|5Pl‘DiEEt5 1 = |EFiIE5 |Eﬁervices | (=l
: Sl

«& 3 A

E\‘ﬁ W JInternalFrame Form. .,
¥ Build
E Clean and Build

Selaﬁjuthya akan dimunculkan sebuah window untuk menentukan nama file dan lokasi
penyimpanan. Isikan Class Name dengan nama frmKalkulator, package isi dengan pilihan

oop. Selanjutnya klik tombol Finish.

Steps Name and Location

1. Choose File Type Class Mame: |FrmKth.|Iat0r |
2. Name and Location

Project: oo |
Location: | Source Packages w |
Package: v

Created File: (55 META-INF.services
] oop
[ oop.resources
] oop.resources. busyicons

4. Mendesain Form
Tambahkan beberapa control swing ke dalam form frmKalkulator seperti tampilan berikut.

Bilangan 1 | |[ + H ¥ ]

Bilangan 2

L
Hasil I:I

[ Clear ][ Close ]

i
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Sedangkan untuk mengubah nama kontrol, klik kanan->Change Variabel Name. hal ini berlaku
untuk seluruh kontrol di dalam netbeans.
- 1
. Edit Text
E Change Yariable Mame ...

Atur nama control dan propertynya seperti table berikut:

Kontrol Property Setting
JTextField Name bill
JTextField Name bil2
JTextField Name hasil
JButton Name btambah
Text +
JButton Name bkali
Text X
JButton Name bkurang
Text -
JButton Name bbagi
Text /
JButton Name bclear
Text Clear
JButton Name cmdclose
Text Close

Selanjutnya untuk menuliskan kode program, anda dapat mengklik tombol Source pada
frmKalkulator.java.

EI] frrnkalkulatar, java x[
Sal Ece |Design | |E

1) Tambahkan kode program pada bagian
public class frmKalkulator extends javax.swing.JInternalFrame {

dengan
inta,b,c;

2) Kklik kanan pada tombol btambah, pilih Events>Action>actionPerformed. Selanjutnya anda
akan dibawa ke mode penulisan program.

+ ¥ I 1akel Label Button
Edi: Text Togale Butt - Check B
oggle Buttan — Check Bo:
- Change Yariable Mame ... =
Bind b ®— Radio Button &~ Button Gr

Action

b actionPerformed [btambahActionPerformed]

3) Tulis kode pada btambah, sebagai berikut:

private void btambahActionPerformed(java.awt.event.ActionEvent evt) {
// TODO add your handling code here:
a Integer.parselnt(bill._getText());
b Integer.parselnt(bil2.getText());
c =a+ b;
hasil.setText(Integer.toString(c));

3

4) Pada tombol bkali, tulis kode sebagai berikut:
private void bkaliActionPerformed(java.awt.event.ActionEvent evt) {
a = Integer.parselnt(bill.getText());
b = Integer.parselnt(bil2.getText());
c=a?>*b;
hasil.setText(Integer.toString(c));
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5) Pada tombol bkurang, tulis kode sebagai berikut:

private void bkurangActionPerformed(java.awt.event.ActionEvent evt) {
a Integer.parselnt(bill._getText());
b Integer.parselnt(bil2_getText());
c=a - b;
hasil.setText(Integer.toString(c));

}
6) Padatombol bbagi, tulis kode sebagai berikut:

private void bbagiActionPerformed(java.awt.event.ActionEvent evt) {
a = Integer.parselnt(bill.getText());
b Integer.parselnt(bil2_getText());
c=a/ b;
hasil.setText(Integer.toString(c));

}
7) Padatombol bcelar, tulis kode sebagai berikut:

private void bclearActionPerformed(java.awt.event.ActionEvent evt) {
bill.setText('"");
bil2_setText(");
hasil.setText(""");
bill.requestFocus();
}

8) Padatombol cmdclose kode sebagai berikut:

private void cmdcloseActionPerformed(Java.awt.event.ActionEvent evt) {
this.dispose();
}

5. Mensetting Project Utama
Agar setiap kali anda menjalankan project, project OOP selalu dijalankan pertama kali. Klik
kanan nama project OOP->pilih Set as Main Project.

6. Kemudian buka file dengan nama OOPView.java. klik kanan—=>pilih Open.

@] Frmkalkulato Edit g
7. Tambahkan kontrol Desktop Pane pada bagian Swing Containers ke menu utama.
= Swing Containers

|:| Panel ﬁ Tabbed Pane
1 split Pane [H scroll Pane
[O Tool Bar :% Deskkop Pane
| L= el Lo
8. Selanjutnya Klik pada bagian File->klik kanan—>pilih Add Form Pallete->Menu Item.
Filr " Heln
Edit Text

hange Yariable Mame ...
Bind [
Events 4

Set Action, ..
add From Palette

Menwu Ikem

9. Tambahkan menu dengan teks isian Kalkulator, kemudian variable name mnuKalkulator.
10. Selanjutnya klik kanan pada menu item Kalkulator->Events—>Actions—>ActionPerformed.

8|Page




11. Tambahkan kode pada bagian mnuKalkulator sebagai berikut:
private void mnuKalkulatorActionPerformed(java.awt.event.ActionEvent evt) {
frmKalkulator frmKalkulator=new frmKalkulator();

JjDesktopPanel.add(frmKalkulator, javax.swing.JLayeredPane.DEFAULT_LAYER);
frmKalkulator.show();

}

12. Kemudian anda dapat menjalankan program dengan menekan tombol F6 pada keyboard.

Basic Application Example |Z||E|r5__(|

File Help

Bilangan 1 |ED [ + | [ % ]

Bilangan 2 |5 - !

Hasil 55

[ Clear ] [

Tugas Praktikum :
Jawablan pertanyaan berikut:
1) Apa fungsi control JDesktopPane yang ditambahkan pada menu utama?
2) Sebutkan dan jelaskan 3 buah file yang ditambahkan secara otomatis ketika sebuah project
terbentuk?
3) Kenapa setiap control di dalam form harus diberi title dan nama?
4) Kenapa form yang ditambahkan dalam project bertipe JinternalFrame Form?
5) Apakah fungsi dari perintah berikut:
Integer.parselnt()
Integer.toString()

Diperiksa tanggal : Nama Laboratorium : Nomor Komputer :
Dosen Pengampu:
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JURUSAN TEKNIK KOMPUTER
PROGRAM D3 TEKNIK KOMPUTER
POLITEKNIK NEGERI SRIWIJAYA PALEMBANG

SI | PEMROGRAMAN BERORIENTASI Praktikum 3 Kontrol program Waktu 90
OBJEK dengan If dan Switch menit

Lecturer : M. Miftakul Amin, S. Kom., M. Eng.

Tujuan : 1. Mahasiswa mengenal kontrol logika program if dan switch di dalam java.
2. Mahasiswa dapat menentukan dan menggunakan kontrol logika if dan
switch program dalam java.
Perlengkapan : Software Netbeans. 6.0

1. Menambah Form frmBobotNilai.java
Tambahkan sebuah form dengan tipe JinternalForm dengan nama frmBobotNilai.java ke

dalam project OOP.

Masukkan bobok nilai

Huruf Mutu

Proses ] [ Close ]

1
Atur nama control dan propertynya seperti table berikut:

Kontrol Property Setting

JTextField Name bobot

JTextField Name huruf

JButton Name cmdproses
Text Proses

JButton Name cmdclose
Text Close

Selanjutnya untuk menuliskan kode program anda dapat mengikuti langkah-langkah berikut:
1) Kklik kanan pada tombol cmdproses, pilih Events—>Action—>actionPerformed. Selanjutnya

anda akan dibawa ke mode penulisan program. Tulis kode sebagai berikut:
private void cmdprosesActionPerformed(Java.awt.event.ActionEvent evt) {
int s_bobot = Integer.parselnt(bobot.getText());
if (s_bobot==4){
huruf_setText(""A™);
}else if(s_bobot == 3){
huruf_setText("'B™);
}else if(s_bobot == 2){
huruf_setText(*'C™");
}else if(s_bobot == 1){
huruf_setText("'D"™);
Yelse{
huruf_setText("'E™);
}

}

2) Padatombol cmdclose kode sebagai berikut:
private void cmdcloseActionPerformed(java.awt.event.ActionEvent evt) {
this.dispose();
¥
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2. Mensetting Project Utama
Agar setiap kali anda menjalankan project, project OOP selalu dijalankan pertama kali. Klik
kanan nama project OOP->pilih Set as Main Project.

3. Kemu

4. Selanjutnya Klik pada bagian File->klik kanan->pilih Add Form Pallete->Menu Item.

File Heln
Edit Texk

hange Yariable Mame ...
Bind [
Events 4

Set Action, ..

add From Palette
Menu Ikem
Tambahkan menu dengan teks isian BobotNilai, kemudian variable name mnuBobotNilai.

Selanjutnya klik kanan pada menu item Bobot Nilai=>Events—>Actions—-> ActionPerformed.
Tambahkan kode pada bagian mnuKalkulator sebagai berikut:

Nowu

private void mnuBobotNilaiActionPerformed(java.awt.event.ActionEvent evt) {
frmBobotNilai frmBobotNilai=new frmBobotNilai();
JDesktopPanel.add(frmBobotNilai, javax.swing.JLayeredPane. DEFAULT_LAYER);
frmBobotNilai.show();

}

8. Kemudian anda dapat menjalankan program dengan menekan tombol F6 pada keyboard.

. B Basic Application Example

& File  Help

Masukkan bobat nilai

Huruf Muku

A

[ Proses |’ Clase ]
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Basic Application Example

File Help

Masukkan bobat nilai

Huruf Mutu

[ Proses |[ Clase ]

Tugas Praktikum :
1) Modifikasilah program yang telah dibuat dengan menggunakan kontrol seleksi switch!
Letakkan kode program perubahan pada tombol proses.
2) Buatlah program untuk menentukan bahwa sebuah nilai merupakan bilangan ganijil dan
genap! Seperti contoh berikut

Basic Application Example |Z||E|E|

Masukkan Bilangan Bulat Masukkan Bilangan Bulat

Basic Application Example |Z| |E| fg|

File Help

105 |

1| Close

|Bilangan Genap |Bilangan Ganijil |

Diperiksa tanggal : Nama Laboratorium : Nomor Komputer :
Dosen Pengampu:
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JURUSAN TEKNIK KOMPUTER
PROGRAM D3 TEKNIK KOMPUTER
POLITEKNIK NEGERI SRIWIJAYA PALEMBANG

SI | PEMROGRAMAN BERORIENTASI Praktikum 4 Looping dengan for | Waktu 90
OBJEK dan while menit

Lecturer : M. Miftakul Amin, S. Kom., M. Eng.

Tujuan : 1. Mahasiswa mengenal kontrol logika program perulangan di dalam java.
2. Mahasiswa dapat menentukan dan menggunakan kontrol perulangan
dalam program java.
Perlengkapan : Software Netbeans. 6.0

1. Menambah Form frmLooping.java
Tambahkan sebuah form dengan tipe JinternalForm dengan nama frmLooping.java ke dalam
project OOP.

<] B

Masuklkan Jumlah Looping

[ Clear ]l Proses ][ Close ]

Atur nama control dan propertynya seperti table berikut:

Kontrol Property Setting

JTextField Name jumlah

JTextField Name hasil

JButton Name cmdclear
Text Clear

JButton Name cmdproses
Text Proses

JButton Name cmdclose
Text Close

Selanjutnya untuk menuliskan kode program anda dapat mengikuti langkah-langkah berikut:

1) Kklik kanan pada tombol cmdproses, pilih Events—>Action—>actionPerformed. Selanjutnya
anda akan dibawa ke mode penulisan program. Tulis kode sebagai berikut:

private void cmdprosesActionPerformed(Java.awt.event.ActionEvent evt) {

int i;
int s_jumlah = Integer.parselnt(Jumlah.getText());
//naik
for(i=1;i<=s_jumlah;i++){
hasil._setText( hasil.getText() + "™ " + i);
}

3

2) padatombol cmdclear kode sebagai berikut:

private void cmdclearActionPerformed(Java.awt.event.ActionEvent evt) {
Jjumlah._setText(""");
hasil.setText(""");
jumlah._requestFocus();

}

3) Padatombol cmdclose kode sebagai berikut:
private void cmdcloseActionPerformed(java.awt.event._ActionEvent evt) {
// TODO add your handling code here:
this.dispose();
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2. Mensetting Project Utama
Agar setiap kali anda menjalankan project, project OOP selalu dijalankan pertama kali. Klik
kanan nama project OOP->pilih Set as Main Project.

3. Kemudian

4. Selanjutnya Klik pada bagian File->klik kanan->pilih Add Form Pallete->Menu Item.

File Heln
Edit Texk

hange Yariable Mame ...
Bind [
Events 4

Set Action, ..
add From Palette

Menwu Ikem

5. Tambahkan menu dengan teks isian Looping, kemudian variable name mnuLooping.
6. Selanjutnya klik kanan pada menu item Looping—>Events—>Actions—> ActionPerformed.
7. Tambahkan kode pada bagian mnuKalkulator sebagai berikut:

private void mnuLoopingActionPerformed(java.awt.event._ActionEvent evt) {
frmLooping frmLooping=new frmLooping();
JDesktopPanel.add(frmLooping, javax.swing.JLayeredPane.DEFAULT_ LAYER);
frmLooping.show();

}

8. Kemudian anda dapat menjalankan program dengan menekan tombol F6 pada keyboard.

Basic Application Example |:||E|E|
File Help

Masukkan Jumlah Looping

’ Clear ]| Proses |[ Clase ]

|123456?891|]1112131415161?181920

14| Page



File Help

Masukkan Jurnlah Looping

Basic Application Example : §|[$__<|

[ Clear ]| Proses |[ Close ]

(12345678910

Tugas Praktikum :
1) Modifikasilah program untuk menentukan perulangan yang dibuat urut dari besar ke kecil
menggunakan perintah perulangan boleh for ataupun while! Seperti tampilan berikut

Basic Application Example : E|[X|

File Help

Masukkan Jumlah Looping

[ Clear ]| Proses |[ Close ]

|2019181?1615141312111098?654321

Diperiksa tanggal : Nama Laboratorium : Nomor Komputer :
Dosen Pengampu:
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JURUSAN TEKNIK KOMPUTER
PROGRAM D3 TEKNIK KOMPUTER
POLITEKNIK NEGERI SRIWIJAYA PALEMBANG

SI | PEMROGRAMAN BERORIENTASI Praktikum 6 Binding Data Waktu 90
OBJEK menit

Lecturer : M. Miftakul Amin, S. Kom., M. Eng.

Tujuan : 1. Mahasiswa mengetahui dasar-dasar teknik binding data dalam java yang
sangat bermanfaat ketika mengembangkan aplikasi database.
2. Mahasiswa dapat menggunakan beberapa kontrol standar dalam java
untuk menampilkan data.
Perlengkapan : Software Netbeans. 6.0

1. Menambah Form frmBindingData.java
Tambahkan sebuah form dengan tipe JinternalForm dengan nama frmBindingData.java ke
dalam project OOP.

Binding Data Listbox {JList) Binding Data Combo Box {1ComboBo:x)

Item 1 Ikem 1 i

Item 2

Ttem = [ Tampil Combo ]

Item 4 T —

Item 5 [ amp s ]
[ Tampil Tabel ]

Binding Texthox {ITextField)

Binding Data Table (JTable)

Title 1 Title 2 Title 3 Title 4

Atur nama control dan propertynya seperti table berikut:

Kontrol Property Setting
JList Name listbox
JComboBox Name combobox
JTable Name tabel
JTextField Name keterangan
JButton Name cmdtampilcombo
Text Tampil Combo
JButton Name cmdtampillist
Text Tampil List
JButton Name cmdtampiltabel
Text Tampil Tabel

Selanjutnya untuk menuliskan kode program anda dapat mengikuti langkah-langkah berikut:
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1) Pada bagian atas dari package tambahkan kode sebagai berikut:

package oop;

import javax.swing.*;
import javax.swing.event.>;
import java.awt.*;

import java.awt.event.*;

2) Pada bagian public class frmBindingData extends javax.swing.JInternalFrame {
tambahkan kode program berikut:

private DefaultListModel itemList;

3) Buatlah method baru dengan nama tampilltemList() sebagai berikut:

public void tampilltemList(){
itemList = new DefaultListModel();
itemList.addElement(*'S1 Sistem Informasi');
itemList.addElement("'S1 Teknik Informatika");
itemList._addElement(*'S1 Sistem Komputer');
itemList.addElement("'D3 Manajemen Informatika');
itemList._addElement("'D3 Teknik Komputer');
listbox.setModel (itemList);

}
4) Buatlah method baru dengan nama tampilltemCombo() sebagai berikut:

public void tampilltemCombo(){
combobox.removeAllltems();
combobox.addltem(*'S1 Sistem Informasi™);
combobox.addltem(*'S1 Teknik Informatika');
combobox.addltem(*'S1 Sistem Komputer™);
combobox.addltem("'D3 Manajemen Informatika');
combobox.addltem("'D3 Teknik Komputer™);

3

5) Tambahkan method baru untuk menampilkan table seperti berikut:
private javax.swing.table._DefaultTableModel tableModel=getDefaultTabelModel();
private void Tabel(Javax.swing.JTable tb, int lebar[]1 ) {
tb.setAutoResizeMode(JTable.AUTO_RESIZE_OFF);
int kolom=tb.getColumnCount();
for(int i=0;i < kolom;i++) {
Javax.swing.table.TableColumn tbc=tb.getColumnModel () .getColumn(i);
tbc.setPreferredWidth(lebar[i]);
tb.setRowHeight(17);
}
3
private javax.swing.table.DefaultTableModel getDefaultTabelModel() {
return new javax.swing.table_DefaultTableModel(
new Object[1[] {3,
new String [] {"Program Studi'}
)i
boolean[] canEdit = new boolean[]{
false
}:
public boolean isCellEditable(int rowlndex, int columnindex){
return canEdit[columnindex];
3
}:
3

public void tampilltemTabel Q{
tabel .setModel (tableModel);
Tabel (tabel, new int[]1{200});
String data[]=new String[1];
data[0] = "S1 Sistem Informasi';
tableModel .addRow(data) ;
data[0] = "'S1 Teknik Informatika™;
tableModel .addRow(data) ;
data[0] = "S1 Sistem Komputer™;
tableModel .addRow(data) ;
data[0] = ""'D3 Manajemen Informatika";
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tableModel .addRow(data) ;

data[0] = "D3 Teknik Komputer™;

tableModel .addRow(data) ;
3

6) Kemudian pada bagian konstruktor, tambahkan 3 buah pemanggilan method yang telah
dibuat sebelumnya dengan kode berikut:
public frmBindingData() {
initComponents();

tampilltemList();
tampilltemCombo();
tampilltemTabel () ;
}
7) klik kanan pada tombol cmdtampi Icombo, pilih Events—>Action->actionPerformed.
Selanjutnya anda akan dibawa ke mode penulisan program. Tulis kode sebagai berikut:

private void cmdtampilcomboActionPerformed(java.awt.event.ActionEvent evt) {
String s_keterangan = combobox.getSelectedltem().toString();
keterangan.setText(s_keterangan);

}

8) padatombol cmdtampillist kode sebagai berikut:

private void cmdtampillistActionPerformed(java.awt.event_ActionEvent evt) {
String s_keterangan = listbox.getSelectedValue().toString();
keterangan.setText(s_keterangan);

b
9) Padatombol cmdtampi Itabel kode sebagai berikut:

private void cmdtampiltabelActionPerformed(java.awt.event_ActionEvent evt) {
int row = 0O;
row = tabel._getSelectedRow();
keterangan.setText(tableModel .getValueAt(row, 0).toString());

}

2. Mensetting Project Utama
Agar setiap kali anda menjalankan project, project OOP selalu dijalankan pertama kali. Klik
kanan nama project OOP->pilih Set as Main Project.

3. Kemudian buka file dengan nama OOPView.java. klik kanan->pilih Open.

@] FrmGanjiIGerW
@] Frmkallulate Edit
4. Selanjutnya Klik pada bagian File->klik kanan—>pilih Add Form Pallete>Menu Item.

File Heln
Edit Text

Zhange Yariable Mame ...
Bind [
Events 4

Set Action. ..

Add From Palette

Menu Ikem

Tambahkan menu dengan teks isian Binding Data, kemudian variable name mnuBinding.

Selanjutnya klik kanan pada menu item Binding Data > Events—->Actions—> ActionPerformed.

Tambahkan kode pada bagian mnuKalkulator sebagai berikut:

private void mnuBindingActionPerformed(java.awt.event._ActionEvent evt) {
frmBindingData frmBindingData=new frmBindingData();
jDesktopPanel.add(frmBindingData, javax.swing.JLayeredPane.DEFAULT_LAYER);
frmBindingData.show();

No g

b4
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8. Kemudian anda dapat menjalankan program dengan menekan tombol F6 pada keyboard.
Tampilan ketika tombol Tampil Combo diklik.

Basic Application Example
File Help

Binding Data Combo Box {JComboBox)

51 Sistem |Sl Sistern Informasi V|
51 Tekni : .
51 Sistem Komputer | Tampil Comba |
D3 Manajemen Informatika

D3 Teknik Komputer [

Tampil List ]

[ Tampil Tabel ]

Binding Textbox {1TextField)

|Sl Sistern Informasi

Binding Data Table (1Table)

Program Studi
51 Sistem Informasi
51 Teknik Informatika
215 .ompuker
D3 Manajemen Informatika
D3 Teknik Komputer

Basic Application Example
File Help

Binding Data Listbos {JList) Binding Data Combo Box {JComboBox)

51 Sistem Informasi |Sl Sistern Informasi v |
51 Teknik Informatika
51 Sistem Komputer [ Tampil Camba ]
D3 Manajemen Infarmatika
D3 Teknik Komputer

Tampil List i

[ Tampil Tabel ]

Binding Textbox {ITextField)

|51 Teknik Informatika

Binding Data Table {1Table)

Program Studi
51 Sistem Informasi
51 Teknik Informatika
Komputer
D3 Manajemen Informatika
D3 Teknik Komputer
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Basic Application Example
Fil=  Help

Tampilan ketika tombol Tampil Tabel diklik

Binding Data Listhox (JList) Binding Data Comba Box (JComboBox)

51 Sistem Informasi | 51 Sistem Informasi

v

51 Teknik Informatika

S1 Sistern Komputer [ Tampil Comba ]

D3 Manajemen Informatila [

D3 Teknik Komputer Tarnpil List

]

i Tampil Tabel

Einding Texthox (ITextField)

|Sl Sistem Komputer

Binding Data Table {1Table)

Program Studi

31 Siskem Informasi

51 Teknik Informatika

5 Komputer

D3 Manajemen Informatika
D3 Teknik Komputer

Tugas Praktikum :

berikut! Seperti contoh berikut

Basic Application Example
File Help

Masukkan Sembarang Tulisan

[paRMadATa

[ Proses |[ Clear ][ Clase ]

D

D&

DAR,

DARM
DARMA
DARMA]
DARMATA
DARMAIAY
DARMAIAY A

1) Dengan menggunakan teknik perulangan dan control JList buatlah program yang dapat
menampilkan urutan dari setiap karakter yang dimasukkan ke dalam textbox seperti gambar

LEX

Diperiksa tanggal :
Dosen Pengampu:

Nama Laboratorium :

Nomor Komputer :
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JURUSAN TEKNIK KOMPUTER
PROGRAM D3 TEKNIK KOMPUTER
POLITEKNIK NEGERI SRIWIJAYA PALEMBANG

SI | PEMROGRAMAN BERORIENTASI Praktikum 6 Membangun Database | Waktu 90
OBJEK menit

Lecturer : M. Miftakul Amin, S. Kom., M. Eng.

Tujuan : 1. Mahasiswa dapat menggunakan tools untuk membangun sebuah
database.
2. Mahasiswa dapat membuat table, memodifikasi table, dan memanipulasi
datanya.
Perlengkapan : Software navicate 8/phpmyadmin

1. Membuat koneksi ke database
Pada panel Coonection—->klik kanan->pilih New Connection.

€ Navicat B Lite for MySQL

File Wiew Tools ‘Window Help

24 & E
Connection  Manage Users Ta
Connections

/E koneksi

,.i_?f Cpen Conneckion

BH

E- Mew Connection. .. k

3 Remove Connection

j Connection Properties. ..

Kemudian atur property dari parameter koneksi seperti gambar berikut:
Z[Connection] f5__<|

General | advanced | SsL | SsH | HTTP

Connection Mame: |koneksi |
Host name/IP address: |I0calhost |
Part:

User name: |r00t |

Password: |** |

Save Password

’ Test Connection Ok l ’ Cancel
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Selanjutnya untuk menguji koneksi, klik tombol Test Connection. Sampai dimuculkan informasi
bahwa koneksi yang anda lakukan sukses.

3

Ll
1 } Connection Successful

Selanjutnya anda dapat menutup koneksi dengan mengklik tombol OK.

2. Membuka Koneksi.
Anda dapat mengklik node koneksi, kemudian klik kanan->pilih Open Connection.
€ Navicat B Lite for MySQL

File Wiew Tools ‘Window Help

g & ||O

Connecktion  Manage Users Table

Connections
g oncksi

E Open Conneckion

A
3. Membuat Database.

Setelah koneksi terbuka, anda dapat klik kanan node koneksi->pilih New Database...
€’ Navicat B Lite for MySQL

File Wew Tools Window Help

|

4 &

Connection  Manage Users Table

Connections

= {f’__‘f koneksi

E Close Connection

i. Mew Connection. .
3 Remove Connection

j Connection Properties. ..

8 Cpen Database

f Mew Database. ..

' Consale... 3

Pada bagian Enter Database Name isikan dbsipmb. Kemudian klik tombol OK.
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Create New Database

)

Enter database name:

dbsipmb|
Character set:
Default character set L
Collation:
L
(0.4 l [ Zancel

4. Membuat Tabel.
Klik node database dbsipmb->ekspand dengan melakukan double klik. Pada node tables>klik
kanan%EiIih New Table.

=4 dbsiprmb
8 Tables
£ Stored
:é Events Execute Batch File. ..
_E_ETEUEHE: Refresh .
Buat desain table mprodi dengan struktur sebagai berikut:
Marmne |Type |Length Decimals |.ﬁ.llu:|w Pl | |
B |prodi char 2 n O e
_|nama varchar 50 n
_|ienjang char 2 0
Kemudian buat table muser dengan struktur sebagai berikut:
Mame |T3.-'pe |Length |Decimals |J:'.||E|L-‘-.l Mull | |
P |uid char 6 1] O e
_|pwd char 6 1]
Dan terakhir buat struktur table tregistrasi dengan desain sebagai berikut:
Mame |T';.-'pe |Length |Decimals |.ﬁ.|||:|w Mull | |
ka char 9 1]
[ noregistrasi char A 1] O e
[ kgldaftar date 1] 1]
" |nama varchar 50 1]
[ pilihani char 2 n
[ pilinanz char 2 n
: pilinans char 2 n
__|tmplahir varchar 50 n
kqllahir date 1] 1]
" sex char 1 1]
B zlamat |varchar 255 1]

5. Mengisi table.
Untuk mengisi table, anda cukup memilih salah satu table, kemudian klik kanan->Open table.
Isikan table mprodi dengan record seperti berikut:
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prodi nama jenjang

L 01 Sistemn Kompuker

|0z Teknik Kompuker D3
|03 Manajemen Informatika D3
|04 Sistern Informasi 51
oS Teknik Informatila 51
| 06 Manajemen 51
|07 Akunkansi 51
|08 Akunkansi ]

Tugas Praktikum :

1) Gambarlah relasi yang menandakan hubungan atara table mprodi dan tregistrasi dari skema

table yang telah dibuat.

Diperiksa tanggal : Nama Laboratorium :
Dosen Pengampu:

Nomor Komputer :
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JURUSAN TEKNIK KOMPUTER
PROGRAM D3 TEKNIK KOMPUTER
POLITEKNIK NEGERI SRIWIJAYA PALEMBANG

SI | PEMROGRAMAN BERORIENTASI Praktikum 7 Membangun Koneksi | Waktu 90
OBJEK menit

Lecturer : M. Miftakul Amin, S. Kom., M. Eng.

Tujuan : 1. Mahasiswa dapat menjelaskan tahapan dalam membangun koneksi
antara java dengan database.
2. Mahasiswa dapat membuat program untuk menampilkan data.
Perlengkapan : Software Netbeans. 6.0

1. Membuat Project SIPMB
Dari menu netbeans—>File New Project->pilih Java->pilih Java Dekstop Application. beri nama
project dengan SIPMB. Pastikan project baru telah ditambahkan ke dalam IDE netbeans anda.

:Projects L1 XIEFiIes : Services
=8 SIPME ~
=108 Source Packages 1
- E-[] META-INF.services
= sipmb
& siPMEAboutBox. java
& SIPMBARD.java
-8 sirveview java
2. Mereferensi Driver MySQL.
Klik kanan Libraries pada project SIPMB->pilih Add JAR/Folder...
@
=@ Testlib  Add Project...
ﬁ U Add Library...

Pilih lokasi dimana driver mysq|l disir-nan.
Lookin: | () com v 2EE

ﬂ mysgl-conneckor-java-5. 1. 6-bin

File: narne: |mysql-cu:unnectu:ur-java-5. 1.6-bin.jar | [ Open ]
Files of bype: |Classpath Entry (Folder, ZIP or JAR File) w | icancel

Pilih driver mysql-connector-java-5.1.6-bin.jar. kemudian klik tombol Open. Pastikan file jar
tersebut telah terdaftar pada libraries anda.
3. Membuat sebuah form dengan nama frmEntryProdi.java
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Ikem 1
Ikem 2
Ikem 3
Item 4
Item S

Close

Buat setting setiap kontrol sebagai berikut:
Kontrol Property Setting
JList Name listProdi
JButton Name cmdclose
Text Close

Selanjutnya untuk menuliskan kode program anda dapat mengikuti langkah-langkah berikut:

1) Pada bagian atas dari package tambahkan kode sebagai berikut:

package sipmb;

import javax.swing.*;
import javax.swing.event.*;
import java.sql.*;

2) Pada bagian public class frmEntryProdi extends javax.swing.JInternalFrame {
tambahkan kode program berikut:

private DefaultListModel itemList;
private Connection con;

private Statement stmt;

private String sql;

String driver = "com.mysql.jdbc.Driver";
String database = "jdbc:mysql://localhost:3306/dbsipmb™;
String uid = "root";

String pwd = "'sa';

3) Buatlah method baru dengan nama tampilltemList() sebagai berikut:
public void tampilltemList(){
try{

Class.forName(driver);

con = DriverManager.getConnection(database,uid,pwd);

itemList = new DefaultListModel();

stmt =con.createStatement();

sql = "SELECT prodi,nama, jenjang FROM mprodi";

ResultSet rsProdi = stmt.executeQuery(sql);

while(rsProdi.next()){

itemList.addElement(rsProdi.getString(‘'prodi') +

" " + rsProdi.getString(“'nama') +
" " + rsProdi.getString("'jenjang'™) );
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6.

10.

listProdi.setModel (itemList);

}catch(Exception ex){
JOptionPane.showMessageDialog(null, "Error Connection™);
System.out.printin(ex.getMessage());
}
}

4) Pada bagian cmdclose->Events—>Actions—>ActionPerformed tulis kode berikut:
private void cmdcloseActionPerformed(java.awt.event.ActionEvent evt) {
this.dispose();

5) Kemudian pada bagian konstruktor, tambahkan 1 buah pemanggilan method yang telah

dibuat sebelumnya dengan kode berikut:
public frmEntryProdi() {
initComponents();

tampilltemList();

}
Mensetting Project Utama
Agar setiap kali anda menjalankan project, project SIPMB selalu dijalankan pertama kali. Klik
kanan nama project SIPMB->pilih Set as Main Project.
Kemudian buka file dengan nama SIPMBView.java. klik kanan->pilih Open.
=& SIPME

E}@ Source Packages

-] META-INF.services

EIEE| sipmb

& stPMBAboutBDX. java
& siPmBapp.java

- EEEE
>|E[] FrmEntryPr
>|ﬁ[] FrrLogin, jz Edit

Selanju:tnyga Klik pada bagian File->klik kanan->pilih Add Form Pallete->Menu Item.

File: Heln
Edit Text

hange Yariable Name ...
Bind [
Events 4

Set Action, ..

Add From Palette
Menwu Ikem

Tambahkan menu dengan teks isian Data Program Studi, kemudian variable name
mnudataprogramstudi.

Selanjutnya klik kanan pada menu item Data Program Studi - Events - Actions >
ActionPerformed.

Tambahkan kode pada bagian mnuDataProgramStudi sebagai berikut:

private void mnuDataProgramStudiActionPerformed(java.awt.event_ActionEvent evt)

{
frmEntryProdi frmEntryProdi = new frmEntryProdi();

JjDesktopPanel.add(frmEntryProdi, javax.swing.JLayeredPane.DEFAULT_LAYER);
frmEntryProdi .show() ;
}

Kemudian anda dapat menjalankan program dengan menekan tombol F6 pada keyboard.

Tampilan ketika tombol Tampil Combo diklik.
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01 Sistern Informasi 51

03 Akuntansi 51

03 Manajemen Informatika D3
04 Sistem Kompuker 51

05 Teknik Informatika 51

06 Manajemen Informatika 51
02 Teknik Informatika 51

07 Manajermen 51

09 Akuntansi D3

Close

Tugas Praktikum :
1) Dengan menggunakan JTabel, buat sebuah form untuk menampilkan data table/record yang
berasal dari table mprodi.

Diperiksa tanggal : Nama Laboratorium : Nomor Komputer :
Dosen Pengampu:
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JURUSAN TEKNIK KOMPUTER
PROGRAM D3 TEKNIK KOMPUTER
POLITEKNIK NEGERI SRIWIJAYA PALEMBANG

Sl PEMROGRAMAN Praktikum 8-9 Manipulasi Data Waktu 90
BERORIENTASI OBJEK menit

Lecturer : M. Miftakul Amin, S. Kom., M. Eng.

Tujuan : 1. Mahasiswa dapat membuat aplikasi manipulasi data.
2. Mahasiswa dapat mengembangkan aplikasi berdasarkan event list yang
terjadi.
Perlengkapan : Software Netbeans. 6.0

1. Membuat Form Entry Prodi.
Tambahkan sebuah form dengan nama frmAdministrasiProdi.java. Kemudian desain form
seperti tampilan berikut:

=k

fode Prodi | H Ea ]

Mama Prodi i |

Jenjang ! !

[ Baru ][ Simpan ][ Ipdate _H_ Hapus _H Close ]

Title 1 Title 2 Title: 3 Title: 4

Buat setting setiap kontrol sebagai berikut:
Kontrol Property Setting
JTextField Name prodi
JTextField Name nama
JTextField Name jenjang
JTable Name gridProdi
JButton Name cmdbaru
Text Baru
JButton Name cmdSimpan
Text Simpan
JButton Name cmdUpdate
Text Update
JButton Name cmdHapus
Text Hapus
JButton Name cmdClose
Text Close

Selanjutnya untuk menuliskan kode program anda dapat mengikuti langkah-langkah berikut:
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1) Pada bagian atas dari package tambahkan kode sebagai berikut:

package sipmb;

import javax.swing.*;
import javax.swing.event.>;
import java.sql.*;

import java.awt.*;

import java.awt.event.*;

2) Pada bagian public class frmAdministrasiProdi extends javax.swing.JInternalFrame {
tambahkan kode program berikut:

private Connection con ;
private Statement st;
String data[]=new String[3];

String driver = "com.mysqgl.jdbc.Driver";
String database = "jdbc:mysql://localhost:3306/dbsipmb";
String uid = "root";

String pwd = "'sa'";

3) Buatlah method untuk menampilkan data di tabel sebagai berikut:
private javax.swing.table.DefaultTableModel tableModel=getDefaultTabelModel();

private void Tabel(Javax.swing.JTable tb, int lebar[] ) {
tb.setAutoResizeMode(JTable.AUTO_RESIZE_OFF);
int kolom=tb.getColumnCount();
for(int i=0;i < kolom;i++) {
Javax.swing.table.TableColumn tbc=tb.getColumnModel () .getColumn(i);
tbc.setPreferredWidth(lebar[i]);
tb.setRowHeight(17);

}

private javax.swing.table.DefaultTableModel getDefaultTabelModel() {
return new javax.swing.table.DefaultTableModel (

new Object[]1[] {3,

new String [1 {"Kode","Nama Prodi","Jenjang"}

>

boolean[] canEdit = new boolean[]{

false, false, false

p&blic boolean isCellEditable(int rowlndex, int columnindex){
return canEdit[columnindex];

private void setDefaultTable() {
String stat =""';
try {
Class.forName(driver);
con = DriverManager.getConnection(database,uid,pwd);
st = con.createStatement();
String SQL = "SELECT * FROM mprodi ORDER BY prodi ASC'";
ResultSet res = st.executeQuery(SQL);
while(res.next()){
data[0] = res.getString(l);
data[1] res.getString(2);
data[2] = res.getString(3);
tableModel .addRow(data) ;
}

} catch (Exception ex) {
JOptionPane.showMessageDialog(null, "Error Connection™);
}
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4) Tambahkan kode untuk cmdCari dengan kode sebagai berikut:
private void cmdCariActionPerformed(java.awt.event.ActionEvent evt) {
try{

String s_prodi = prodi.getText();

st = con.createStatement();

String sql = "SELECT * FROM mprodi WHERE prodi=""+ s_prodi + """;

ResultSet rsProdi = st.executeQuery(sql);

if(rsProdi.next(Q){
nama.setText(rsProdi.getString(‘'nama™));
Jjenjang.setText(rsProdi.getString(""jenjang™));

Yelse{
JOptionPane.showMessageDialog(null,"Data Tidak Ada™);

}
}catch(Exception ex){
JOptionPane.showMessageDialog(null,"Error Pencarian™);
}

¥
5) Tambahkan kode untuk cmdbaru, sebagai berikut:
private void cmdBaruActionPerformed(java.awt.event.ActionEvent evt) {
bersih(Q);

6) Tambahkan kode untuk cmdSimpan sebagai berikut:
private void cmdSimpanActionPerformed(Java.awt.event.ActionEvent evt) {

// TODO add your handling code here:

String s_prodi = prodi.getText();

String s_nama = nama.getText();

String s_jenjang = jenjang.getText();

//validasi isian

if (s_prodi.isEmpty()){
JOptionPane.showMessageDialog(null,"Kode Masih Kosong™);
prodi .requestFocus();
return;

}

if (s_nama.isEmpty(){
JOptionPane.showMessageDialog(null,"Nama Masih Kosong™);
nama.requestFocus();
return;

}

if (s_jenjang.isEmpty()){
JOptionPane.showMessageDialog(null,"Jenjang Masih Kosong™);
jenjang.requestFocus();

return;
}
try{
st = con.createStatement();
String sql = "INSERT INTO mprodi(prodi,nama,jenjang) VALUES(™"

+ s_prodi + "7,
+ s _nama + "%,""
+ s_jenjang + "")";
int done = st.executeUpdate(sql);

data[0] = prodi.getText();
data[1] = nama.getText();
data[2] = jenjang.getText();

tableModel . insertRow(0, data);
bersih(Q);
}catch(Exception ex){
JOptionPane.showMessageDialog(null,"Error Simpan™);
}

¥
7) Tambahkan kode cmdupdate, kode sebagai berikut:
private void cmdUpdateActionPerformed(java.awt.event.ActionEvent evt) {

String s_prodi = prodi.getText();

String s_nama = nama.getText();

String s_jenjang = jenjang.getText();

//validasi isian

if (s_prodi.isempty()){
JOptionPane.showMessageDialog(null,"Kode Masih Kosong™);
prodi .requestFocus();
return;

}

ifT (s_nama.iseEmpty()){
JOptionPane.showMessageDialog(null,"Nama Masih Kosong™);
nama.requestFocus();
return;
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if (s_jenjang.isEmpty()){
JOptionPane.showMessageDialog(null,"Jenjang Masih Kosong™);
Jenjang.requestFocus();

return;
¥
try{
st = con.createStatement();
String sql = "UPDATE mprodi SET nama=""

+ s_nama + ,jenjang=
+ s_jenjang + """ WHERE prodi=""
+ s_prodi + """;
int done = st.executeUpdate(sql);
data[0] = prodi.getText();
data[1l] = nama.getText();
data[2] = jenjang.getText();
tableModel . removeRow(row) ;
tableModel . insertRow(row,data);
bersih(Q);
}catch(Exception ex){
JOptionPane.showMessageDialog(null,"Error Update');
}

T
8) Tambahkan kode cmdhapus, kode sebagai berikut:
private void cmdHapusActionPerformed(java.awt.event.ActionEvent evt) {

String s_prodi = prodi.getText();

String s_nama = nama.getText();

String s_jenjang = jenjang.getText();

//validasi isian

if (s_prodi.isempty()){
JOptionPane.showMessageDialog(null,"Kode Masih Kosong™);
prodi .requestFocus();
return;

}

if (s_nama.isEmpty()){
JOptionPane.showMessageDialog(null,"Nama Masih Kosong™);
nama.requestFocus();
return;

}

if (s_jenjang.isEmpty()){
JOptionPane.showMessageDialog(null,"Jenjang Masih Kosong™);
jenjang.requestFocus();
return;

if(JOptionPane.showConfirmDialog(null,"Data Dihapus? ","Konfirmasi",

JoptionPane .OK_CANCEL_OPTION, JOptionPane . INFORMATION_MESSAGE)==JOptionPane.OK_OPTION)

{

try{
st = con.createStatement();
String sql = "DELETE FROM mprodi WHERE prodi="""
+ s_prodi + ""'";
int done = st.executeUpdate(sql);
data[0] = prodi.getText();
data[l] = nama.getText();
data[2] = jenjang.getText();
tableModel . removeRow(row) ;
bersih(Q);
}catch(Exception ex){
JOptionPane.showMessageDialog(null,"Error Hapus Data');
¥

}

3
9) Tambahkan kode untuk cmdClose, kode sebagai berikut:
private void cmdCloseActionPerformed(Java.awt.event.ActionEvent evt) {
this.dispose(Q);

10) Tambahkan method Tampil untuk menampilkan data ketika grid yang berisi data diklik.
int row = 0;
public void Tampil(Q{
row = gridProdi.getSelectedRow();
prodi.setText(tableModel .getvValueAt(row, 0).toString());
nama.setText(tableModel .getValueAt(row, 1).toString(Q));
Jenjang.setText(tableModel .getValueAt(row, 2).toString(Q));
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11) Tambahkan kode pada gridProdi->klik kanan->Events—>MouseActionPerformed.
private void gridProdiMouseClicked(java.awt.event.MouseEvent evt) {
if (evt.getClickCount()==1) {
TampilQ);

¥
12) Tambahkan method untuk membersikan teks isian sebagai berikut:
public void bersihQ{
prodi .setText(""");

Jenjang.setText("");
prodi .requestFocus();

}
13) Kemudian pada bagian konstruktor, tambahkan 3 buah pemanggilan method yang telah
dibuat sebelumnya dengan kode berikut:
public frmAdministrasiProdi() {
initComponents();
gridProdi .setModel (tableModel);
Tabel(gridProdi, new int[]{50,200,70});
setDefaultTable();

}

2. Mensetting Project Utama
Agar setiap kali anda menjalankan project, project SIPMB selalu dijalankan pertama kali. Klik
kanan nama project SIPMB->pilih Set as Main Project.

3. Kemudian buka file dengan nama SIPMBView.java. klik kanan->pilih Open.
= &5 SIPMB

=@ Source Packages

-] META-INF.services

EIEE| sipmb

- [d stPMBAboutBDX. java
& SIPMBARD.java

- EREETe
Eﬂ FrmEntrvPrH
: *Eﬂ frmLoginje  Edit

4. Selanjutnya Klik pada bagian File=>klik kanan=>pilih Add Form Pallete->Menu Item.

File Heln
Edit Text

Zhange Yariable Mame ...
Bind [
Events 4

Set Action. ..

Add From Palette

Menu Ikem

5. Tambahkan menu dengan teks isian Administrasi Program Studi, kemudian variable name
mnuAdministrasiProdi.

6. Selanjutnya klik kanan pada menu item Administrasi Program Studi=> Events - Actions ->
ActionPerformed.

7. Tambahkan kode pada bagian mnuAdministrasiProdi sebagai berikut:

private void mnuAdministrasiProdiActionPerformed(java.awt.event.ActionEvent evt) {
frmAdministrasiProdi frmAdministrasiProdi = new frmAdministrasiProdi();
JjDesktopPanel.add(frmAdministrasiProdi, javax.swing.JLayeredPane.DEFAULT_LAYER);
frmAdministrasiProdi.show();
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8. Kemudian anda dapat menjalankan program dengan menekan tombol F6 pada keyboard.

Tampilan ketika tombol Tampil Combo diklik.

kode Prodi || H Cari ]

Mama Prodi | |

Jenjang I:I

[ Baru ][ Simpan ] [ Update ][ Hapus ][ Close ]
Kode Marma Prodi Jenjang
01 Siskern Informasi 51
nz Teknik Informatika 51
03 Manajemen Informatika D3
04 Siskern kompuker 51
05 Teknik Informatika 51
06 Manajemen Informatika 31
o7 Manajemen 51
0a Akuntansi 51
03 Akuntansi D3

Tugas Praktikum :

1) Dengan teknik manipulasi data yang sama, buatlah form dengan nama
frmAdministrasiUser.java. yang berfungsi sebagai tambah data, ubah data, update data, dan
hapus data serta menampilkan data ke dalam grid.

2) Panggil form frmAdministrasiUser.java melalui menu utama.

Diperiksa tanggal : Nama Laboratorium : Nomor Komputer :
Dosen Pengampu:
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JURUSAN TEKNIK KOMPUTER
PROGRAM D3 TEKNIK KOMPUTER
POLITEKNIK NEGERI SRIWIJAYA PALEMBANG

Sl PEMROGRAMAN Praktikum 10-11 | Aplikasi Multitable | Waktu 90
BERORIENTASI OBJEK menit

Lecturer : M. Miftakul Amin, S. Kom., M. Eng.

Tujuan : 1. Mahasiswa mampu membuat form untuk memasukkan data ke dalam
table yang melibatkan lebih dari 1 tabel.
2. Mahasiswa mampu membinding data menggunakan beberapa kontrol
standar di java.
Perlengkapan : Software Netbeans. 6.0

1. Menambah Form frmEntryPendaftaran.java
Tambahkan sebuah form dengan tipe JinternalForm dengan nama frmEntryPendaftaran.java
ke dalam project SIPMB.

Tahun Ajaran Tanggal Daftar . Marmar Pendaftaran

Nara | | Filihan 1
|
Tempat Lahir | | |Item1 b
, Filihan 2
Tanggal Lahir |
: [Ieem 1 v
Jenis Kelamin |Tkem 1 %
[tem 1 | i
Alarnat | |Item 1 - i
Title 1 Title 2 Title 3 Title 4 Baru

Simpan

Close

Atur nama kontrol dan propertynya seperti table berikut:

Kontrol Property Setting
JTextField Name ta
JTextField Name tgldaftar
JTextField Name noregistrasi
JTextField Name nama
JTextField Name tmplahir
JTextField Name tgllahir
JComboBox Name sex
JTextField Name alamat
JComboBox Name pilihanl
JComboBox Name pilihan2
JComboBox Name pilihan3
JTable Name gridRegistrasi
JButton Name cmdbaru
Text Baru
JButton Name cmdsimpan
Text Simpan
JButton Name cmdclose
Text Close
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Selanjutnya untuk menuliskan kode program anda dapat mengikuti langkah-langkah berikut:

1) Pada bagian atas dari package tambahkan kode sebagai berikut:

package sipmb;

import javax.swing.*;
import javax.swing.event.*;
import java.sql.*;

import java.awt.*;

import java.awt.event.*;
import java.util_Date;

2) Pada bagian public class frmEntryPendaftaran extends javax.swing.JInternalFrame {
tambahkan kode program berikut:

private Connection con ;

private Statement st;

private DefaultListModel itemList;
String data[]=new String[11];

String driver = "com.mysgl.jdbc.Driver";
String database = "jdbc:mysql://localhost:3306/dbsipmb";
String uid = "root";

String pwd = "'sa';

3) Buatlan method baru dengan nama tampilltemSex() sebagai berikut:

public void tampilltemSex(){
sex.removeAllltems();
sex.addltem(*'L™);
sex.addltem('P™);
¥

4) Buatlah method baru dengan nama tampilltemCombol() sebagai berikut:

public void tampilltemCombol(){
pilihanl.removeAllltems();
try {
Class.forName(driver);
con = DriverManager.getConnection(database,uid,pwd);
st = con.createStatement();
String SQL = "SELECT * FROM mprodi ORDER BY prodi ASC";
ResultSet res = st.executeQuery(SQL);
while(res.next()){
pilihanl._addltem(res.getString(“prodi'™)
+ "|" + res.getString(*'jenjang'™)
+ "|"™ + res.getString(“'nama'));

3
} catch (Exception ex) {
JOptionPane.showMessageDialog(null, "Error Connection™);
}
¥

5) Buatlah method baru dengan nama tampilltemCombo2() sebagai berikut:
public void tampilltemCombo2(){
pilihan2._removeAllltems();
try {
Class.forName(driver);
con = DriverManager.getConnection(database,uid,pwd);
st = con.createStatement();
String SQL = "SELECT * FROM mprodi ORDER BY prodi ASC";
ResultSet res = st.executeQuery(SQL);
while(res.next()){
pilihan2._addltem(res.getString(“prodi')
+ "|" + res.getString(*'jenjang')
+ "|" + res.getString(*'nama’™));

} catch (Exception ex) {
JOptionPane.showMessageDialog(null, "Error Connection™);

}
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6) Buatlah method baru dengan nama tampilltemCombo3() sebagai berikut:

public void tampilltemCombo3(){
pilihan3.removeAllltems();
try {
Class.forName(driver);
con = DriverManager.getConnection(database,uid,pwd);
st = con.createStatement();
String SQL = "SELECT * FROM mprodi ORDER BY prodi ASC";
ResultSet res = st.executeQuery(SQL);
while(res.next()){
pilihan3.addltem(res.getString(“prodi'™)
+ "|" + res.getString("jenjang')
+ "|"™ + res.getString(“'nama'));

}
} catch (Exception ex) {
JOptionPane.showMessageDialog(null, "Error Connection');
}
3

7) Buatlah method baru TanggalOtomatis() sebagai berikut:

public void bersih(Q){
ta.setText('"");
noregistrasi.setText(""");
nama.setText('"");
tmplahir.setText("");
alamat.setText(""");

3

8) Buatlah method baru untuk menampilkan data ke dalam grid(JTable) sebagai berikut:
//segmen untuk menampilkan tabel data
private javax.swing.table.DefaultTableModel tableModel=getDefaultTabelModel();
private void Tabel(Javax.swing.JTable tb, int lebar[]1 ) {
tb.setAutoResizeMode(JTable.AUTO_RESIZE_OFF);
int kolom=tb.getColumnCount();
for(int i=0;i < kolom;i++) {
Javax.swing.table.TableColumn tbc=tb.getColumnModel () .getColumn(i);
tbc.setPreferredWidth(lebar[i]);
tb.setRowHeight(17);
}
}
private javax.swing.table.DefaultTableModel getDefaultTabelModel() {
return new javax.swing.table_DefaultTableModel(
new Object[1[] {3,
new String [1 {"TA.","No.Registrasi","Tgl.Daftar™, " Nama","Pilihan 1","Pilihan
2","Pilihan 3","Tmp. Lahir","Tgl. Lahir","”Sex","Alamat"}
X
boolean[] canEdit = new boolean[]{
false, false, false, false
}:
public boolean isCellEditable(int rowlndex, int columnindex){
return cankEdit[columnindex];

private void setDefaultTable() {
String stat ="";
try {
Class.forName(driver);
con = DriverManager.getConnection(database,uid,pwd);
Statement stt = con.createStatement();
String SQL = "SELECT * FROM tregistrasi';
ResultSet res = stt.executeQuery(SQL);
while(res.next()){
data[0] = res.getString("ta™);

data[1] = res.getString(‘'noregistrasi');
data[2] = res.getString(""tgldaftar™);
data[3] = res.getString('nama');

data[4] = res.getString("pilihanl™);
data[5] = res.getString(“pilihan2™);
data[6] = res.getString("pilihan3™);
data[7] = res.getString(""tmplahir'™);
data[8] = res.getString("tgllahir™);
data[9] = res.getString(‘'sex");
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data[10] = res.getString(“alamat™);
tableModel .addRow(data) ;

3
} catch (Exception ex) {

JOptionPane.showMessageDialog(null, "Error Connection™);
3

3

9) Kemudian pada bagian konstruktor, tambahkan 8 buah pemanggilan method yang telah
dibuat sebelumnya dengan kode berikut:
public frmEntryPendaftaran() {
initComponents();
tampilltemSex();
tampil1temCombol();
tampi l1temCombo2();
tampil1temCombo3();
TanggalOtomatis();
gridRegistrasi .setModel (tableModel);
Tabel (gridRegistrasi, new int[]{70, 90, 70, 70, 70,
70, 70, 70, 70, 70, 70});
setDefaultTable();

}
10) klik kanan pada tombol cmdbaru, pilih Events—> Action->actionPerformed. Selanjutnya anda
akan dibawa ke mode penulisan program. Tulis kode sebagai berikut:
private void cmdbaruActionPerformed(java.awt.event_ActionEvent evt) {
bersih(Q);
ta.requestFocus();

}

11) pada tombol cmdsimpan pilih Events->Action—>actionPerformed, tuliskan kode program

sebagai berikut:
private void cmdsimpanActionPerformed(Java.awt.event.ActionEvent evt) {
String s_ta=ta.getText();
String s_noregistrasi=noregistrasi.getText();
String s_tgldaftar=tgldaftar.getText();
String s_nama=nama.getText();
String s_pilihanl=pilihanl.getSelectedltem().toString().substring(0, 2);
String s_pilihan2=pilihan2.getSelectedltem().toString().substring(0, 2);
String s_pilihan3=pilihan3.getSelectedltem().toString().substring(0, 2);
String s_tmplahir=tmplahir.getText();
String s_tgllahir=tgllahir._.getText();
String s_sex=sex.getSelectedltem().toString();
String s_alamat=alamat.getText();

if ((s_ta.isempty()) | (s_noregistrasi.isEmpty())
| (s_nama.isEmpty()) | (s_pilihanl.isEmpty()))
{J0ptionPane.showMessageDialog(null,"data tidak boleh kosong, silahkan
dilengkapi'™);
ta.requestFocus();
Yelse {

try {
Class.forName(driver);

con = DriverManager.getConnection(database,uid,pwd);

Statement stt = con.createStatement();

String SQL = "INSERT INTO
tregistrasi(ta,noregistrasi,tgldaftar,nama,pilihanl,pilihan2,pilihan3,tmplahir,tgllah
ir,sex,alamat) values(""+ s_ta +"","+

"""+ s_noregistrasi +"","+
s_tgldaftar +"","+
S_nama +"","+
s_pilihanl
s_pilihan2
s_pilihan3
s_tmplahir
s_tgllahir
s_sex +"7,"
s_alamat +"")";
stt.executeUpdate(SQL);
data[0] = ta.getText();
data[l] = noregistrasi.getText();

........
FEFffiésd
RN

+
+
+
+
+
+

£
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data[2] = tgldaftar.getText();

data[3] = nama.getText();

data[4] = pilihanl_getSelectedltem().toString().substring(0, 2);
data[5] = pilihan2.getSelectedltem().toString().substring(0, 2);
data[6] = pilihan3.getSelectedltem().toString().substring(0, 2);
data[7] = tmplahir.getText();

data[8] = tgllahir.getText();

data[9] = sex.getSelectedltem().toString();

data[10] = alamat.getText();
tableModel . insertRow(0, data);
bersihQ);
} catch (Exception ex) {
JOptionPane.showMessageDialog(null,”Error Connection™);
}

3

12) Pada tombol cmdclose kode sebagai berikut:
private void cmdcloseActionPerformed(java.awt.event.ActionEvent evt) {
this.dispose();
}

2. Mensetting Project Utama
Agar setiap kali anda menjalankan project, project SIPMB selalu dijalankan pertama kali. Klik
kanan nama project SIPMB->pilih Set as Main Project.

3. Selanjutnya Klik pada bagian File->klik kanan—>pilih Add Form Pallete>Menu Item.

File: Heln
Edit Text

hange Yariable Name ...
Bind
Events

Set Action, ..

add From Palette

Menwu Ikem

4. Tambahkan menu dengan teks isian Pendaftaran->Entry Pendaftaran, kemudian variable name
mnuEntryPendaftaran.

5. Selanjutnya klik kanan pada menu item Entry Pendaftaran - Events = Actions =
ActionPerformed.

6. Tambahkan kode pada bagian mnuKalkulator sebagai berikut:
private void mnuEntryPendaftaranActionPerformed(java.awt.event.ActionEvent evt) {
frmEntryPendaftaran frmEntryPendaftaran = new frmEntryPendaftaran();
JjDesktopPanel.add(frmEntryPendaftaran, javax.swing.JLayeredPane.DEFAULT_LAYER);
frmEntryPendaftaran.show();
}

7. Kemudian anda dapat menjalankan program dengan menekan tombol F6 pada keyboard. Akan
dimunculkan window untuk mengisi data pendaftaran mahasiswa baru seperti gambar berikut:
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Tahun Ajaran ’ED‘B_,I'ZD_IEI_| Tanggal Daftar ED_IID_STD? | Momor Pendaftaran _ZDD:BE |
harna |Fati3-'ah | pilihan 1
Tempat Lahir |Palembang| | |01]51|Sistem Informasi |
N e —— Pilhan 2
Tanggal Lahir |2011-03-07 |
- i |IZIS|51 | Teknik Informatika ~ |
Jenis Kelamin |F‘ ~
I Pilihan 3
&larnat IJI. Merdeka 2 Bandar Lampung |D;r|51 [Manajemen w |
TA. Mo, Registrasi Tal.Daftar Marna Pilihan 1 PFilihan 2 Pilihan : Baru
200972010 |01 2011-03-07 |Yuda Pratama|01 0z 03 .
200972010 (200902 2011-03-07  |Prayoga Se... |01 a7 04
4 *

Tugas Praktikum :
1) Buatlah program untuk menyediakan fungsionalitas update dan hapus data pendaftaran
mahasiswa baru.

Diperiksa tanggal : Nama Laboratorium : Nomor Komputer :
Dosen Pengampu:
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JURUSAN TEKNIK KOMPUTER
PROGRAM D3 TEKNIK KOMPUTER
POLITEKNIK NEGERI SRIWIJAYA PALEMBANG

SI | PEMROGRAMAN BERORIENTASI Praktikum 12 Membuat Laporan Waktu 90
OBJEK menit

Lecturer : M. Miftakul Amin, S. Kom., M. Eng.

Tujuan : 1. Mahasiswa mampu membuat laporan menggunakan Jasper Report.
2. Mahasiswa dapat mendesain laporan yang informatif dan menarik.
Perlengkapan : Jasper Report

1. Membuka Jasper Report
Untuk membuat laporan, anda dapat membuka software Jasper Report. Dari menu Start >
Program->Jasper Soft>iReport-nb-0.9.1->iReport-nb-0.9.1. sesaat kemudian akan ditampilkan
window IDE iReport.

[® iReport 0.9.1 (c) 2008 JasperSoft Corp. M[=1E3
File Edit “ew Tools ‘Window Help
-S4 B a@ I |
:Report Ins... 0 = ‘Palette Ik x
[ outline not available
: Properties Ir =
:iReport outpuk ¥ =
S
s
£ >

2. Menambahkan Driver MySQL.
Agar iReport dapat berkomunikasi dengan database MySQL, maka diperlukan driver untuk
menghubungkan antara iReport dengan MySQL. Dari menu Tools->pilih Options. Pada bagian
iReport->pilih tab Classpath. Klik tombol Add/JAR. Pilih lokasi dimana anda menempatkan file
mysgl-connector-java-5.1.6-bin.jar. Pilih file tersebut kemudian klik tombol Open.

41| Page




Nl B a4 B &

iReport General Editar Fants & Colors Keymap Miscellaneous
| General | Classpath | Fontpath |
Classpath
[™ add JAR(s) / path to the classpath 3] A J0R
Look in: ||ﬁ lib v | _f 7 Add Folder
@ Mame Size| Type C Remove
! ﬂ commons-digester-1.7 137 KB Executable Jar File gA
My Recent |&l] commans-javaflow-20060411 95KE Executable Jar File ]
Documents |&f] commans-logging-1.0.2 26 KE Executable Jar File &
= ﬂ cammons-logging-api-1.0.2 18 KB Executabls Jar File 8
L_ ﬂ DEPaket 38 KE Executabls Jar File 8
Desktop ﬁ jasperreports-2.0.5 1,912 KB Executable Jar File 3
ﬂ jasperreparts-2,0.5-applet 303 KE Executabls Jar File 3
- ﬂ jasperreparts-2.0.5-javaflow 1,945 KE Executabls Jar File 3
’] ﬂ jalendar-1.3.2 124 KB Executable Jar File 6
ﬂ jdt-compiler-3.1.1 1,184 KB Executable Jar File T

[y D I
[y Documents 556 KB Execukable Jar File 8

637 KB Executable Jar File 3
116 KB Executable Jar File 8

-

: ﬂ swing-worker-1,1 11KB Executable Jar File 8
My Computer | | | urobject 6KE Exerutabls Jar File 8w
-g < | 3
File name: |mysq\-c0nnector-java-5. 1.6-bin.jar | [ Open ]

Iy Metwork

Places Files of type: |*.jan *.zip v | Cancel

3. Membuat Koneksi ke MySQL.
Untuk membuat koneksi ke MySQL, dari menu Tools->Report Dataources.

) iReport 0.9.1 [c) 2008 JasperSoft Co
File Edit Yiew BGEEEN Window Help
Palette

:Report Ins...

D Cutline not & Templates
Plugins
Opkions

Pada window Connections/Datasources klik tombol New.
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&

Eﬁ Connections / Datasources

Mame Datasource bype Default Mew
Empty datasource |Empty data source |
Modify
Delete

Set as default

Pilih Database JDBC Connection, kemudian klik tombol Next.

a
X)

S/
a—

S

Datasource

Select the datasource bype

Database JDEC connection
MetBeans Database JDEC connection
%ML File dakasource

lavaBeans sek datasource

File 5% datasource
JRDatasourceProvider

Cuskam JRDataSource

Empty data source

Hibernate connection

Spring loaded Hibernate connection
EJEQL connection

AMLA Server

Mondrian OLAP connection

Query Executer mode

Test Next = H Zancel ]

Kemudian isikan parameter koneksi sesuai dengan konfigurasi server MySQL anda.
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a
X

L—
“sa=" Database JDBC connection

Mame |u:||:usi|:um|:u |

o~

|

IDEC Driver |cum.mysql.jdbc.Driver L |

JDEC URL |jd|:|c:mysql:,l',l'll:ncalhast,l'dbsipmb |
IDEC URL 'Wizard

Server Address |I|:u:alhnst |

Database |d|:usi|:um|:u |[ Wizard ]

Usernarie |r|:u:|t |

Password |" | []5ave passwaord

1, jLabelt

[ Tesk H Save H Cancel

Klik tombol Test untuk menguji koneksi, dan jika sukses klik tombol Save. Pastikan centang
Save Password agar password dapat diingat oleh sistem setiap kali bekerja dengan laporan.
Anda dapat melihat bahwa koneksi yang saat ini aktif adalah dbsipmb pada bagian info koneksi.

dbsipmb v | ey

4. Membuat Laporan.
Untuk membuat laporan anda dapat memilih menu File-> Report Wizard. Maka akan tampil
gambar seperti di bawah ini.
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m New report [g|

Steps Name and location

Mame and lacation
Query

Fields

Group by...
Layout

Finish

[ R

Report name: |rptProdi| |

Laocation: |D:'l,Arsip—Mengajar'l,genap-2D10-2011'|,Java2SE'|,SIPMB'I,Iib| [ Browse... ]

File: |D:'l,Arsip—Mengajar'l,genap-2D10-201 14 JavazsEYSIPMEYibYrptPradi. jrxml |

Isikan report name dengan rptProdi. Lokasi file tempatkan di dalam folder lib tepat dibawah
lokasi project SIPMB anda. Selanjutnya klik tombol Next. Akan dimunculkan window untuk
memilih koneksi dan perintah query mengambil record sebagai sumber laporan. Isikan perintah

SQL.
Eﬂ New report f$__(|
Steps Query
L. Mame and location
2. Query Connections | Data Sources
3. Fields |dbsipmb hd | [ Hew ]
4 Groupby...
5 Layout Query (SOL)
8. Finish SELECT * FROM mprodi
Design query = Load query | ’ [ Save query

Klik tombol Next. Selanjutnya dimunculkan window untuk memilih field mana saja yang akan
ditampilkan di dalam laporan.
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I New re port g|

Steps Fields

1. Wame and location pradi

2. Query nama ‘
3 Fislds
4 Group by...

5. Layout

£, Finish

<

Klik tombol Next. Selanjutnya dimunculkan window memilih grup, pilih field prodi untuk
mengelompokkan group.

m New report

Steps Group by...

Mame and location
Query

Fields

Graup by... Group 1
Layouk
Finish

Go (D g 9 [0 2

Klik tombol Next. Pada layout pilih tabular layout.

Steps Layout

Mame and location

Query

Figlds

Group by... () Calumnar Layout
Layout
Finish

Gh [ en B0 [ o=
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Kemudian klik tombol Next. Maka akan dimunculkan desain laporan yang telah dibuat seperti
tampilan berikut:

QrptProdi.jrxml x

Desigrier ®ML Preview = @ &

0

Classic template

0

u]
T N I T N T A

prodi $F {prodi}
i $F{nama} $F{jenjang}
=
=
new Date() "Page "+ FV{PAGE_NUMBER}+" of "+ §V
o

Klik tombol Preview untuk melihat hasil laporan.

L rptProdijreml - x

Designer XML Freview || (&

BE o «n D0 @&~

Classic template

prodi 01

Sistem Informasi S1
prodi 08
Akuntansi S1
prodi 03
Manajemen Informatika D3

Tugas Praktikum :
1) Coba tampilkan laporan laporan dengan model layout columnar.
2) Buat laporan yang sama untuk menampilkan daftar record dari table user. Beri nama file
rptUser.jrxml.
3) Buat laporan untuk menampilkan data dari table tregistrasi. Beri nama file laporan
rptRegistrasi.

Diperiksa tanggal : Nama Laboratorium : Nomor Komputer :
Dosen Pengampu:
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JURUSAN TEKNIK KOMPUTER
PROGRAM D3 TEKNIK KOMPUTER
POLITEKNIK NEGERI SRIWIJAYA PALEMBANG

SI | PEMROGRAMAN BERORIENTASI Praktikum 13 Memanggil Laporan | Waktu 90
OBJEK Lewat Form menit

Lecturer : M. Miftakul Amin, S. Kom., M. Eng.

Tujuan : 1. Mahasiswa mampu memanggil laporan yang telah dibuat menggunakan
form di dalam java.
2. Mahasiswa dapat menyebutkan komponen apa saja yang harus
diintegrasikan ke dalam aplikasi untuk memanggil laporan.
Perlengkapan : Jasper Report

1. Mengintegrasikan Komponen Pendukung Laporan

Agar anda dapat memanggil laporan dari aplikasi yang dibuat menggunakan netbeans

tambahkan komponen-komponen penting lewat netbeans.

Pilih project->klik kanan pada bagian Libraries>Add JAR/Folder.

=& SIPMB

l,_a Source Packages
Jj Tesk Packages
E} = ibraries
: % Swii  Add Project... - appframewt

B8 Swil  Add Library.. - swing-works
£ Properties L

Tambahkan kc;-rﬁponeh'—kdmbonen berikut:

commons-beanutils-1.7.jar
commons-collections-2.1.jar
commons-digester-1.7.jar
commons-javaflow-20060411.jar
commons-logging-1.0.2.jar
commons-logging-api-1.0.2.jar
jasperreports-2.0.5.jar
jdt-compiler-3.1.1.jar

2. Menambahkan Form Cetak Prodi.
Tambahkan form frmCetakProdi.java. Kemudian desain form seperti tampilan berikut:

[ Cetak ]’ Close ]

Atur property setiap kontrol form seperti table berikut:

Kontrol Property Setting

JButton Name cmdcetak
Text Cetak

JButton Name cmdclose
Text Close
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Selanjutnya untuk menuliskan kode program anda dapat mengikuti langkah-langkah berikut:

1) Pada bagian atas dari package tambahkan kode sebagai berikut:

package sipmb;

import java.util_HashMap;

import net.sf.jasperreports.engine.JasperFillManager;
import net.sf.jasperreports.engine.JasperPrint;
import net.sf.jasperreports.engine.JasperReport;
import net.sf.jasperreports.engine.util.JRLoader;
import net.sf.jasperreports.view.JasperViewer;

import java.io.File;

import java.sql.Connection;

import java.sql.DriverManager;

import javax.swing.*;

import java.awt.*;

import java.awt.event.*;

import java.sql.*;

import javax.swing.JOptionPane;

2) Pada bagian public class frmCetakProdiParameter extends javax.swing.JInternalFrame {
tambahkan kode program berikut:

private Connection con ;

private Statement st;

String data[]=new String[3];

String driver = "com.mysqgl.jdbc.Driver";

String database = "jdbc:mysql://localhost:3306/dbsipmb";
String uid = "root";

String pwd = "'sa';

3) klik kanan pada tombol cmdcetak, pilih Events—>Action->actionPerformed. Selanjutnya anda

akan dibawa ke mode penulisan program. Tulis kode sebagai berikut:
private void cmdcetakActionPerformed(java.awt.event.ActionEvent evt) {
try{
String NamaFile="lib/rptProdi.jasper";
HashMap parameter = new HashMap();
Class.forName(driver);
con = DriverManager.getConnection(database,uid,pwd);
File reportfile = new File(NamaFile);
JasperReport jasperReport =(JasperReport)JRLoader.loadObject(reportfile.getPath());
JasperPrint jasperPrint =JasperFillManager.fillReport(jasperReport, parameter, con);
JasperViewer .viewReport(jJasperPrint,false);
JasperViewer .setDefaul tLookAndFeelDecorated(true);
} catch (Exception e) {
JOptionPane.showMessageDialog(null, "Data tidak dapat dicetak !,
""Cetak Data',JOptionPane.ERROR_MESSAGE);

}

4) padatombol cmdclose kode sebagai berikut:
private void cmdcloseActionPerformed(java.awt.event.ActionEvent evt) {
this.dispose();
}

3. Kemudian buka file dengan nama SIPMBView.java. klik kanan->pilih Open.
=& SIPMB

—HI[F Source Packages
+- [ META-INF services

- sipmb
~[E sPmBAboutBox.java
o |@] STPMBADD.java

o |
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4. Selanjutnya Klik pada bagian File->klik kanan—>pilih Add Form Pallete->Menu Item.

File: Heln
Edit Text

hange Yariable Name ...
Bind [
Events 4

Set Action, ..

Add From Palette
Menwu Ikem

Tambahkan menu dengan teks isian Cetak Prodi, kemudian variable name mnucetakprodi.

Selanjutnya klik kanan pada menu item Cetak Prodi > Events - Actions > ActionPerformed.

Tambahkan kode pada bagian Cetak Prodi Parameter sebagai berikut:

private void mnucetakprodiActionPerformed(java.awt.event.ActionEvent evt) {
frmCetakProdi frmCetakProdi = new frmCetakProdi();
JjDesktopPanel.add(frmCetakProdi, javax.swing.JLayeredPane.DEFAULT_LAYER);
frmCetakProdi.show();

Noo

}
8. Kemudian anda dapat menjalankan program dengan menekan tombol F6 pada keyboard.

Tampilan penambahan Menu ltem Cetak Prodi Parameter.

Basic Application Example

File Pendaftaran NES(MElED

- Cetak Prodi Parameter El@‘
Kemudian masukkan kode program studi yang akan ditampilkan datanya.
Basic Application Example

File Pendaftaran Laporan Help

[ Cetak |[ Close l

Klik tombol Cetak untuk menampilkan hasil laporan berdasarkan filter kode program studi yang
telah dimasukkan.
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« JasperViewer

u TR

EBX

75% v

Classic template

prodi 01

Sistem Informasi 51

prodi 08

Akuntansi S1

prodi 03

Manajemen Informatika D3

prodi 04

Sistem Komputer 51

prodi 05

Teknik Informatika 51 2

< ¥
Fage 1 of 1

Tugas Praktikum :

sebelumnya.

1) Buat form untuk menampilkan laporan rptRegistrasi yang telah dibuat pada pertemuan

Diperiksa tanggal :
Dosen Pengampu:

Nama Laboratorium : Nomor Komputer :
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JURUSAN TEKNIK KOMPUTER
PROGRAM D3 TEKNIK KOMPUTER
POLITEKNIK NEGERI SRIWIJAYA PALEMBANG

SI | PEMROGRAMAN BERORIENTASI Praktikum 14 Memanggil Laporan
OBJEK Berparameter

Waktu 90
menit

Lecturer : M. Miftakul Amin, S. Kom., M. Eng.

Tujuan : 1. Mahasiswa mengetahui teknik pembuatan laporan berparameter.

2. Mahasiswa dapat memanggil laporan berparameter lewat form aplikasi.

Perlengkapan : Software Netbeans. 6.0
Jasper Report

1. Membuat Laporan Berparameter

Buka iReport, dari menu File>New Empty Report. Pada menu isian laporan isi dengan nama
rptProdiParameter.jrxml. Tentukan lokasi penempatan file, tempatkan di dalam folder di lib di
bawah lokasi project SIPMB. Kemduian klik tombol Next, sesaat kemudian akan dimunculkan

window kosong.

Tambahkan parameter baru ke dalam laporan. Klik kanan Parameters—>Add Parameter.
) iReport 0.9.1 (c) 2008 JasperSoft Co

File Edit Wiew Tools ‘Window Help

% GG % i, 1 - dbsipmb

:Report Inspector d0 = EtrptF'deiPe
EL repork name
@ Skyles
EI'%_% Parameters
o REPORW
ZF REPOR
%7 REPOR

POEmE e oo

Designer |

name menjadi prodi.
B '%_E parameterl || 3

§> Fields Copy Chrl+C
- % Wariables Cut Chrh+
- || background M
- title

S:ett'in'g property dari parameter menjadi seperti berikut:

Ut;ah parameter &éﬁj&di_dr'dai,'aehgan mengklik kanan parameterl->rename. Ubah property

: prodi - Properties I =
I=IProperties
Mame prodi [:
Parameter Clazs java.lang.String w [:
Uze as & prompt
= . | |
Tentukan sumber data dengan menekan tombol di sebelah kanan Preview. Kemudian

tentukan sumber datanya seperti gambar berikut:
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Report query | JavaBean Datasource | DataSource Provider | CSY Datasource

Query language |5QL v |

select ¥ from mprodi where prodi=fF{prodi}

Buat desain laporan dengan format sebagai berikut:
E. rptProdifarameter ., jrxml x] h

Designer | HML Preview | (=, & &)

1

....I....|....I....|....I....|....I....|....I....|....I....|....EI||||.||....I....|....E

D_ DETAIL PROGRAM STUDI
D_é Kode Prodi FP{prodit

E Nama Prodi FF{nama}

__; Jenjang FF{jenjang}

Untuk menguji apakah desain laporan kita telah tepat, klik tombol Preview. Kemudian akan
dimunculkan window prompt tempat kita mengisikan parameter laporan.

E-_ﬂ Parameter prompt

You can provide a value for the parameter:

prodi

|DZ v

The class type is: java.lang. String

[ ok J[ s defaut |

Klik tombol OK untuk menampilkan hasil laporan yang telah dibuat. Setelah desain laporan
selesai dibuat selanjutnya anda dapat membuat form untuk memanggil laporan yang telah
dibuat.

2. Menambahkan Form untuk Memanggil Laporan
Tambahkan sebuah form dengan tipe JinternalForm dengan nama
frmCetakProdiParameter.java ke dalam project SIPMB. Desain form seperti gambar berikut:

Masukkan Kode Prodi

[ Cetak, ][ Close ]

Atur nama control dan propertynya seperti table berikut:

Kontrol Property Setting
JTextField Name prodi
JButton Name cmdcetak
Text Cetak
JButton Name cmdclose
Text Close
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Selanjutnya untuk menuliskan kode program anda dapat mengikuti langkah-langkah berikut:

1) Pada bagian atas dari package tambahkan kode sebagai berikut:

package sipmb;

import java.util_HashMap;

import net.sf.jasperreports.engine.JasperFillManager;
import net.sf.jasperreports.engine.JasperPrint;
import net.sf.jasperreports.engine.JasperReport;
import net.sf._jasperreports.engine.util_.JRLoader;
import net.sf.jasperreports.view.JasperViewer;

import java.io.File;

import java.sql.Connection;

import java.sql.DriverManager;

import javax.swing.*;

import java.awt.*;

import java.awt.event.*;

import java.sql.*;

import javax.swing.JOptionPane;

2) Pada bagian public class frmCetakProdiParameter extends javax.swing.JInternalFrame {
tambahkan kode program berikut:

private Connection con ;
private Statement st;
String data[]=new String[3];

String driver = "com.mysqgl.jdbc.Driver";
String database = "jdbc:mysql://localhost:3306/dbsipmb";
String uid = "root";

String pwd = "'sa";

3) klik kanan pada tombol cmdcetak, pilih Events—>Action->actionPerformed. Selanjutnya anda

akan dibawa ke mode penulisan program. Tulis kode sebagai berikut:
private void cmdcetakActionPerformed(Java.awt.event.ActionEvent evt) {
try{

String NamaFile="lib/rptProdiParameter.jasper";

HashMap parameter = new HashMap(Q);

parameter.put(“prodi’,prodi.getText());
Class.forName(driver);
con = DriverManager.getConnection(database,uid,pwd);
File reportfile = new File(NamaFile);
JasperReport jasperReport =(JasperReport)JRLoader.loadObject(reportfile.getPath());
JasperPrint jasperPrint =JasperFillManager.fillReport(jasperReport, parameter, con);
JasperViewer .viewReport(jasperPrint,false);
JasperViewer .setDefaul tLookAndFeelDecorated(true);
} catch (Exception e) {
JOptionPane.showMessageDialog(null, "Data tidak dapat dicetak !,
""Cetak Data'",JOptionPane.ERROR_MESSAGE) ;
b
}

4) padatombol cmdclose kode sebagai berikut:
private void cmdcloseActionPerformed(java.awt.event.ActionEvent evt) {
this.dispose();
}

3. Kemudian buka file dengan nama SIPMBView.java. klik kanan->pilih Open.
= fn SIPMB

—.,_Fj Source Packages

4[] META-INF services
.m[] sipmb

[E siPMBAboUtBax. java
[ SIPMBApR.jav
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4. Selanjutnya Klik pada bagian File->klik kanan—>pilih Add Form Pallete->Menu Item.

File: Heln
Edit Text

hange Yariable Name ...
Bind [
Events 4

Set Action, ..

Add From Palette
Menwu Ikem

5. Tambahkan menu dengan teks isian Cetak Prodi Parameter, kemudian variable name
mnucetakprodiparameter.

6. Selanjutnya klik kanan pada menu item Cetak Prodi Parameter - Events - Actions -
ActionPerformed.

7. Tambahkan kode pada bagian Cetak Prodi Parameter sebagai berikut:
private void mnucetakprodiparameterActionPerformed(java.awt.event.ActionEvent evt) {
frmCetakProdiParameter frmCetakProdiParameter = new frmCetakProdiParameter();
JDesktopPanel.add(frmCetakProdiParameter, javax.swing.JLayeredPane.DEFAULT_LAYER);
frmCetakProdiParameter.show();
}
8. Kemudian anda dapat menjalankan program dengan menekan tombol F6 pada keyboard.

Tampilan penambahan Menu ltem Cetak Prodi Parameter.

Basic Application Example
File Pendaftaran NEE(elslEl
Cekak Prodi

Zetak Prodi Parameter

Kemudian masukkan kode program studi yang akan ditampilkan datanya.
Basic Application Example

File Pendaftaran Laporan Help

Masukkan Kode Prodi

o |

[ Cetak ][ Close l

Klik tombol Cetak untuk menampilkan hasil laporan berdasarkan filter kode program studi yang
telah dimasukkan.
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Jas perViewer |Z| |E| f'5__<|

Q@0 (]|

DETAIL PROGRAM STUDI
Kode Prodi 03 W
Nama Prodi Manajemen
Jenjang D3
< . b

Tugas Praktikum :
1) Buat laporan yang menampilkan detail laporan pendaftaran mahasiswa baru dengan

parameter berdasarkan noregistrasi.
2) Panggil laporan menggunakan form yang telah dibuat pada tugas 1). Dengan mengisikan
parameter noregistrasi dari form.

Diperiksa tanggal : Nama Laboratorium : Nomor Komputer :
Dosen Pengampu:
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